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You can also highlight a number of tasks and then click on the indent button to indent the entire collection of tasks at once. Leveling Steps in the Leveling process are only a few, but it is important to understand what each option does.
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Build and refine your plan. Put together your team, schedule, and budget. Achieve the results you want. Build realistic schedules with Project, and learn how to keep costs under control. Track your progress. Measure your performance, make course corrections, and manage changes. Create attractive reports. Communicate clearly to stakeholders and team members using charts, tables, and dashboards.

Show and hide more. Table of contents Product information. Project Management: The Missing Manual 1. Click the box below the Resource Name column for the task you need the resource to be assigned. From the dropdown, choose the resource name.

In the following screenshot as an example. You can also select multiple resources to work on a single task. Now click the Assign button. Double-click the Task Name. Click the Resources tab. Click the cell below the Resource Name column. Select the resource from the dropdown list. The window is split in two, Gantt Chart view and Task Form view below it.

In the Task Form view, click under the Resource Name column and select the resource. We can also assign other material resources to the same task. In the Gantt Chart view, you can also look at the project summary task, to note the duration, start and finish dates of the plan.

In the following example, Assign Resources is the project summary task identified as Task 0. MS Project — Track Progress MS Project Once your project plan is ready in MS Project, it becomes essential for a project manager to measure the actuals in terms of work completed, resources used and costs incurred and to revise and change information about tasks and resources due to any changes to the plans.

A Project Manager should not assume that everything is progressing according to plan and should always keep track of each task. Resistance to formal tracking of project management data is normal.

You can overcome resistance to tracking by explaining your expectations, explaining the benefits of tracking, and training people to track the task themselves. Save a Baseline To evaluate project performance you need to create a baseline against which you will compare the progress.

One needs to save the baseline, once a plan is fully developed. Of course, due to rolling wave planning or progressive elaboration needed to manage projects one can always add new tasks, resources, constraints and costs to the plan.

Also note, it makes sense to save the baseline before entering any actual values such as percentage of task completion. These multiple baselines seem contrary to the definition of baseline. You want to develop separate baseline plans for risk response and recovery. You will see Baseline Gantt bars displayed together with the current Gantt bars. Update the Baseline for the Entire Project This simply replaces the original baseline values with the currently scheduled values.

Update the Baseline for Selected Tasks This does not affect the baseline values for other tasks or resource baseline values in the plan. Save Multiple Baselines You can save up to 11 baselines in a single plan. The first one is called Baseline, and the rest are Baseline 1 through Baseline  It can be used as a project marker. It is visually easy to see how off-track or on-track the project progress is. Because it only specifies dates, it is simple, clear and easy information.

But sometimes this approach might be fine when the actual work and cost values generated are close enough to your baseline schedule. Select the current date.

Check marks will appear in the indicators column for tasks that have been completed. On the right in the Chart portion, progress bars are generated in the Gantt bars of each task. This table includes Work Scheduled work , Actual, and Remaining columns. Click on Task you want to update. For this task, initial scheduled Work was 16 hours, because 24 hours is greater. In the example, a Baseline is saved, because the Baseline does not change and is used as a comparison.

Note: Actual work is rolled up and also reflects on the summary task. Change Start or Finish field in Actual group. You can fill Actual duration field as well. One does not have to finish collecting survey responses before starting the tabulation.

Click the box under the Type column and choose the relationship according to your requirement. Under Lag heading column, enter the lag in terms of hours, days, weeks, or years. You can also apply lag or lead as a percentage. As Soon As Possible means the task starts as soon as the project starts, if there are no dependencies that would delay it.

So, no fixed start or end dates are imposed by this constraint type, but of course predecessor and successor dependencies are maintained. Default constraint when you schedule from the project finish date. Do not enter a Flexible task start or finish date with this constraint. As Soon As Task is scheduled to begin as early as possible. Do not enter a start or finish date with this constraint.

Start No Earlier Task is scheduled to start on or after a specified date. Must Finish On Task is scheduled to finish on a specified date. Click dropdown box for Constraint type. Choose the constraint you would like to apply.

It is a better idea to use a Deadline Date which has no effect on the scheduling of a task or summary task. MS Project will alert you with a red exclamation symbol in the indicators column, if the scheduled completion of the task exceeds its deadline date. Enter the cost under the Fixed Cost column for the task of interest. Enter a Recurring Task Status meetings, status reports, inspection dates can recur with a particular frequency.

In MS Project , you can specify recurring tasks without having to assign tasks each time separately. You can also assign resources to these task. Enter Task Name and choose Recurrence pattern. You can also choose a specific time for the task to start as well.

You can add time value in the Start box for Recurring Task Information dialog box to change this. In the following figure, start time of AM is entered. While schedule changes are made, it is also likely that the critical path will change from time to time. One needs to always focus on the Critical Path first, when one wants to apply fast-tracking or crashing to shorten the project duration. Slack or Float are key to understanding Critical path.

All task bars in the critical path, in the Gantt Chart View on the right, will turn Red in color. Gantt Chart View displays some limited resource information, as shown in the following screenshot.

It summarizes whether there may be a problem by the red over allocated icon in the indicator column. The Resource Usage view displays resources and all tasks assigned to them underneath the Resource Name. The left-hand side of the screen lists the Resources and the Task Names together with columns of total information for the resource or assignment.

The right-hand side shows a time-phased view. Click on Resource Name column heading. Resolve Resource Over Allocation One would need to either change the scope reduce the amount of work , assign more resources, or accept a longer schedule to resolve overallocation. If you add delay that is less than or equal to the amount of slack on the task, you will not affect the finish date of the project. Substitute Resources or Add Additional Resources You can manually allot some other resource to the task.

You can also right-click on the Time-phased grid in the right hand side window to display amount of overallocation by switching on overallocation. Now you can reduce the assigned hours. In the following example, 8-hour assignment is reduced to 4-hour assignments. You will also notice a new icon in the indicator column to let you know that the assignment work has been edited.

If actual work has been recorded, you must manually reduce the remaining work on the task. Remove Overallocated Resource You can just remove a resource assignment from an overallocated resource. Level Overallocated Resources If resources are overallocated you can use resource-leveling feature in MS Project  It works by either splitting tasks or by adding delay to tasks to ensure the resource is not overloaded.

Leveling can delay the individual task finish dates and even the project finish date. Project does not change who is assigned to each task, total work, or assignment unit values. Project first delays tasks to use up any available slack. Once the slack becomes zero, MS Project makes changes according to priorities, dependency relationships and task constraints such as a Finish No Later Than constraint. You can enter value between 1 and , according to the amount of control you like in the leveling process.

A priority level of will ensure MS Project does not level a particular task. By default, priority is set at or a medium level of control. Tasks that have lower priority are delayed or split before those that have higher priority. Click on the dropdown box and select Priority.

Now you can add priority to each task as required. Leveling Steps in the Leveling process are only a few, but it is important to understand what each option does. Project does leveling and overallocated indicators are removed If leveling is done completely, sometimes this might not happen. In Resource Leveling dialog box, under Level calculations, try to use Manual more often.

For examples, if a resource is overallocated, for say half an hour more in a week, from 40 hours to  Doing so will not level resources, but it will determine when Project displays overallocation indicators next to resource names. In Resource Leveling dialog box, under Level calculations, use the clear leveling values before leveling checkbox is selected.

Doing so will ensure Project removes any existing leveling delays from all tasks and assignments before leveling. Here you choose to level either the entire plan or only assignments that fall within a date range you specify. Numerically higher ID numbers for example, 10 will be delayed before numerically lower ID numbers.

You might want to use this option when your plan has no task relationships or constraints. In Resource Leveling dialog box, under Resolving overallocations, you have several options that you can select.

MS Project will use only the free slack within the existing schedule, which could mean that resource overallocations might not be fully resolved. Selecting this checkbox allows Project to add a leveling delay or split work on assignments if Leveling Can Create Splits in Remaining Work is also selected independently of any other resources assigned to the same task.

This might cause resources to start and finish work on a task at different times. This allows Project to split work on a task or on an assignment if Leveling Can Adjust Individual Assignments on a Task is also selected as a way of resolving overallocation. Selecting this allows Project to level a manually scheduled task just as it would an automatically scheduled task.

This will appear under the fields labeled Cost or Total Cost. At this stage, the project manager would be focusing on collecting, monitoring, analyzing project performance, and updating project status by communicating with the stakeholders. When there is a difference between what is planned and the actual project performance, it is called a Variance.

Variance is mostly measured in terms of Time and Cost. Task Slippage There are several ways to view task with variance. By comparing the currently scheduled Gantt bars with baseline Gantt bars, you can see what tasks started later than planned or took longer to complete. MS Project will filter the task list to show only the tasks filtered in this process. So if you select Slipping Task, you will view only incomplete tasks.

Any task that is already completed will not show up. You will be able to view all relevant information. You can also use filters to see tasks that have run over budget. Resource Cost For some organizations, resources costs are primary costs, and sometimes the only cost, so these need to be closely watched. We can sort the Cost column to see which resources are the most and least costly.

Click the AutoFilter arrow in Cost column heading, when the drop-down menu appears, click on Sort Largest to Smallest.

Project Report Project comes with a set of predefined reports and dashboards. You can create and customize graphical reports for your project as well. There are four options. To show outline no. You will obviously have to change many of these. Doing so requires the following. In the Duration field enter the duration. Note : A milestone is a task whose duration is zero days. Any task can be changed to a milestone by changing duration to zero. You will not need to enter the durations of tasks which have subtasks subordinated below them.

These tasks have their durations calculated as the sum of all the demoted task durations. Consider the following list of tasks: NO. It is not possible for the user to change this. The same can be said for subtasks when they have sub-subtasks.

MS Project accepts durations in minutes, hours, days or weeks. When entering data into the duration filed, use the following designations for minutes m , hours h , days d , or weeks w. The default is days d and therefore, the "d" is optional and need not be entered when the intent is to enter durations in days. MS Project has its own built-in understanding of time and it is making a lot of assumptions about the way in which you work. For example, it is assuming 8-hour work days, five-day work weeks and that you do not work on Sat.

To see this, view the. You can change these, but you cannot assign a task ID number that has already been assigned. For example, it is assuming 8-hour work-days, five-day work weeks and that you do not work on Sat. To see this view the project in the Calendar view; notice the duration of the tasks and how they fall across weekends as necessary to fill up the required number of weekdays.

Inserting Columns You can insert columns within any table in the Gantt view. Make certain that your first task is a summary task under which all other tasks are subordinated. Include a cost column in the entry table next to the duration column. You can also include major function, output, and input columns within the entry table simply by clicking on Insert and then Column and typing in the name of the column, followed by clicking on OK..

To show that a particular task can begin only when the predecessor task has completed, the two tasks must be linked. After you decide the task sequence, you can link the tasks, as follows. In the task name field, select two or more tasks that you want to link. To avoid confusion, it is best to select only a pair of tasks at a time.

The first task you click on will be assumed to be the precedent task and the second task that you click on will be assumed to be the subsequent task. Click the Link task button on the tool bar.

It is the button with the solid chain link icon. MS Project generally links tasks as Finish-to-Start tasks, i. Several precedent tasks can be linked into a single subsequent task, but this has to be done in pairs in which each precedent task is clicked on first, followed by a click on the subsequent task. In the task name field, double click the task you want to link. The task information dialog box appears. Click the predecessor tab.

In the ID field, type the ID number of the predecessor task this is the number in the column to the left of task name field. Click in the Type box and then click the drop down arrow to see the four types of dependency relationships that can be established. You can also select link under the Edit menu item on the menu bar after selecting the pair of tasks to be linked. In these latter cases, the analyst wants tasks to start together or finish together.

To change the link type, identify the starting task by clicking on it. Select the predecessors tab and click on the link type field. To do so, begin in the Gantt View with the Entry table visible. Slide the partition to the right to expose as much of the entry table as possible. You should see two side-by-side columns the start column and the finish column.

By changing any of the dates in these columns, you are setting a hard date constraint. If you do so, a flag will appear in the very first column of the entry table, the column labeled I for information.

If you rest the cursor on that flag, a message appears that informs you of the hard date constraint that has been applied to the task. Only one hard date constraint can be set per task at the start date or at the stop date, but not both. Resources can be places, departments, businesses, people, equipment--anything required to complete an activity. When you create an assignment, you assign a resource to a task.

The resource issue makes the project. You can assign: Individual resources Assign resources part time Several resources Remove resources from a task Replace one resource with another. In the Task name field, select the task to which you have to assign a resource.

Click on the assign resource button on the tool bar button with 2 faces on it. In the Name field, type in the name of the resource. Click assign. This is a bad assumption in the software business because as Brooks [1] pointed out, men and months are not interchangeable unless there is no interaction between them.

If you decide to split your job with another person, you will have to spend some time training the other person to do your part of the job. Then you will have to interact with the other person as the two of you together build the interfaces that are necessary between each person s module s.

Clearly, the time is not split in half. In the Task name field, select the task to which you have to remove a resource. Click on the assign resource button button with 2 faces on it. Select the resource you want to remove. Click Remove. To print the required view,. The numbers to the left will appear automatically if you add the WBS column as demonstrated in class. The numbers shown in the WBS column above are there to indicate subordination.

This is precisely what the 1. Likewise, Management Supervisor Technical Clerical. Notice that, for the walk-throughs, all resources get assigned. MS Project will try to cut the duration to something less than one day. You must re-set the duration to one day for the walk-throughs once all resources have been assigned. Explain why summary tasks have no stated duration in the table above. Explain why the first subordinate task immediately below a summary task has no predecessor.

The end result of all of these tasks and assignment entries is the following:. It also helps you to determine how closely the final project cost matches its estimated cost and also helps in planning for the future. For hourly rates, you can assign a standard rate, which is the rate you pay a resource during normal working hours. Rate is the amount you will pay the resource for any overtime that it does. To resources that charge a flat amount to do a job, you can assign a fixed cost per use.

On the View baron the left, click Resource sheet 2. In the Std. Rate, Ovt. On the View Bar, click Gantt Chart. On the View menu, click on Table, select Cost from the list and then click on Cost. In the Fixed Cost field for the task, type-in the cost 4.

A fixed resource cost is added to other resource costs when MS Project calculates the total cost of a task, but doesn t depend on the time a resource spends working on the task. In the Task Name field, select a task. On the Window menu, click Split. In the Resource Name field, select the resource name. If a new, undefined resource is to be assigned, it must be added to the list, so do so. On the format menu, point to details and then click Resource Cost.

In the Task type box, click Fixed Duration. In the units field for the resource, type 0 and then click OK 8. In the Cost field, type the fixed resource cost. On the Window menu, click Remove Split. Notice how this task is displayed on the Gantt Chart. You can:. View cost per resource. View the total project cost. View cost per task The sum of individual task costs make up most if not all of the total project cost. To view the total cost of each task 1.

On the vertical View Bar on the left, click Gantt Chart. Select View on the menu bar, click Table, and then choose Cost. Scroll the table on the left to view the Total Cost field. Alternatively, pull the partition back to the right to view more of the table and less of the Gantt Chart.

View the cost per Resource This helps you to know the total cost of that resource for all the tasks the resource is assigned to. On the vertical View Bar on the left, click Resource Sheet. On the Project menu, click Project Information. Click Statistics.

Perhaps you would like to view project costs on the Entry table which is the default table that loads up with MS Project when it is booted. You would like an additional column to appear right after the name field and right before the duration field. First position the highlight anywhere in the duration column. The click on the insert item on the menu bar. Then, click on Column In the Column Definition dialog box that appears, click on the drop down arrow associated with the Field Name field, the first field in the box.

The list of columns that you can insert appear alphabetized by name. Scroll to cost and click on it. Now, click on the OK button in the upper right corner of the box. The column now appears in your table exactly where you want it. And, now you can see all of your costs. The main goals of analyzing your project plan are to: Shorten the schedule, to meet project deadline.

Distribute the work load evenly, by resolving resource over allocations, so that no resources are overworked. Reduce costs to a minimum, to save money and complete the project within your budget. The main factors that affect how MS Project determines a task s start and finish dates are: Placement. In a logically ordered set of tasks, the tasks are usually performed in the order in which they appear in the task list. Several factors affect duration, but, in general, the longer the duration you enter, the later a task finishes.

Changing the duration may change the task finish date. Task dependencies. The type of link you establish between two tasks determines whether the successor task starts after the predecessor task is complete. By replacing one type of link with another, you can change the task s start and finish dates and, perhaps the project end date. Overlap and delay. The overlap or lead-time you add between two tasks causes the successor task to begin earlier.

The delay or lag time between two tasks causes the successor task to begin later. You can force a task to start or finish on or near a date you specify by entering a start or finish date yourself or you can change the default constraint, as soon as possible to an inflexible constraint such as Must start on or Finish no later than.

Its however better to let MS Project calculate and, if the schedule changes, recalculate. Assigned resources. When you assign resources to a task, the task duration can change. Generally, more the resources you assign to a task, shorter its duration becomes. If you assign resources to a task, then by default, MS Project calculates a task duration based on the amount of work required to complete the task, the number of resources allotted, the working times and work assigned to the resources.

By changing the amount of work required to accomplish a task, you can change the task duration and thus the final date. Task type. By default each task is a fixed units task. You can change the task type to fixed duration or fixed work. Tasks that can delay a project are called critical tasks and the ones that do not delay are called non-critical tasks.

Critical tasks make up a special path known as the critical path. The critical path is the sequence of tasks that ends on the latest finish date, i.
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